
Ch−¬ng 3  

Sketch 
Sketch (ph¸c ph¶o) lµ b−íc ®Çu tiªn ®Ó t¹o dùng chi tiÕt. Ch−¬ng nµy sÏ tr×nh 

bµy tæng quan vÒ m«i tr−êng Sketch, c«ng cô Sketch vµ tr×nh tù t¹o Sketch. Nh÷ng 

th«ng tin tham kh¶o nhiÒu h¬n, c¸c thÝ dô tr×nh diÔn, vµ chØ dÉn tõng b−íc cô thÓ 

xem thªm trong phÇn trî gióp trùc tuyÕn (OnlineHelp) vµ Tutorial. 

3.1. Giíi thiÖu chung 

3.1.1. C«ng dông cña Sketch 

M« h×nh mµ ta t¹o ra trong Autodesk Inventor ®−îc liªn kÕt víi Sketch c¬ së 

(Underlying) cña nã. Khi söa ®æi  Sketch, m« h×nh sÏ ®−îc tù ®éng cËp nhËt. 

Khi muèn t¹o hoÆc chØnh söa Sketch, ph¶i vµo m«i tr−êng Sketch. M«i tr−êng 

nµy bao gåm Sketch vµ c¸c c«ng cô ®Ó t¹o vµ chØnh söa nã. 

Sketch lµ biªn d¹ng cña Feature1 vµ c¸c ®èi t−îng h×nh häc kh¸c (vÝ dô ®−êng 

dÉn hoÆc ®−êng t©m quay) cÇn thiÕt ®Ó t¹o Feature. Ta t¹o m« h×nh 3D tõ  Sketch 

b»ng c¸ch kÐo mét biªn d¹ng theo mét ®−êng dÉn hoÆc quay mét biªn d¹ng quanh 

®−êng t©m nµo ®ã (H×nh 3.1). 

 

 

 

H×nh 3.1: T¹o chi tiÕt 3D b»ng c¸ch 

quay Sketch quanh mét ®−êng t©m.   

 

 

 

M« h×nh 3D cña chi tiÕt ®−îc t¹o trªn c¬ së th«ng tin trong Sketch vµ c¸c c«ng 

cô t¹o Feature. Gi÷a Sketch vµ Feature ®−îc t¹o thµnh lu«n lu«n cã mèi liªn kÕt. 

Mçi khi söa ®æi Sketch th× Feature ®−îc tù ®éng cËp nhËt. §iÒu nµy lµm ®¬n gi¶n  

qu¸ tr×nh thiÕt kÕ vµ chØnh söa chi tiÕt. 

 

                                              
1 Feature lµ mét bé phËn cña chi tiÕt, cã thÓ söa ®æi ®−îc khi cÇn thiÕt. Chi tiÕt vÒ Feature, xem ch−¬ng 

3.   



3.1.2. Khëi ®éng m«i tr−êng Sketch 

Mçi khi  më mét file chi tiÕt míi, m«i tr−êng Sketch ®−îc tù ®éng kÝch ho¹t. 

Nót 2D Sketch ®−îc chän vµ thanh c«ng cô 2D Sketch hiÖn s½n. Khi mét file chi tiÕt 

®· më, cã thÓ kÝch ho¹t Sketch trong Browser (cöa sæ duyÖt) ®Ó kÝch ho¹t c¸c c«ng 

cô trong m«i tr−êng Sketch. Sau khi t¹o m« h×nh tõ Sketch ta cã thÓ trë l¹i m«i 

tr−êng Sketch ®Ó chØnh söa hoÆc bæ sung thªm Sketch míi cho Feature. 

Sau khi Sketch ®−îc t¹o ra, biÓu t−îng Sketch xuÊt hiÖn trong Browser. Khi t¹o 

Feature tõ Sketch, biÓu t−îng Feature xuÊt hiÖn trong Browser, bªn trªn biÓu t−îng 

Sketch t−¬ng øng. Khi trá vµo biÓu t−îng Sketch trong Browser, Sketch t−¬ng øng 

trong cöa sæ ®å ho¹ sÏ ®æi mµu. §Ó chØnh söa Sketch, kÝch ®óp vµo biÓu t−îng cña 

nã trong Browser. 

3.2. C¸c tiÖn Ých t¹o Sketch 

Dynamic inference 

 

Autodesk Inventor t×m kiÕm, hiÓn thÞ vµ tù ®éng g¸n nh÷ng 

rµng buéc khi t¹o Sketch. 

Shared Sketch Ta cã thÓ sö dông mét Sketch ®Ó t¹o nhiÒu Feature hoÆc 

nhiÒu biªn d¹ng (Profile) trong mét m« h×nh chi tiÕt. 

Constrained Drag Ta cã thÓ g¸n c¸c rµng buéc, thay ®æi kÝch th−íc cña Sketch 

vµ t¹o c¸c rµng buéc míi b»ng c¸ch kÐo c¸c ®èi t−îng h×nh 

häc. 

General 

Dimension 

Ta cã thÓ t¹o c¸c kÝch th−íc mét c¸ch nhanh chãng vµ trùc 

quan b»ng nót trong thanh c«ng cô.   

Auto Dimension  Ta cã thÓ ®ång thêi ghi nhiÒu kÝch th−íc, t¹o c¸c rµng buéc 

cho c¸c Sketch trong cïng mét b−íc víi sè thao t¸c Ýt nhÊt. 

Hatching Ta cã thÓ g¹ch  mÆt c¾t cho c¸c vïng trong b¶n vÏ. 

Direct Edge 

Referencing. 

Ta cã thÓ chiÕu c¸c c¹nh cña chi tiÕt lªn mÆt ph¼ng Sketch 

®Ó t¹o ra Sketch míi. 

 3.3. Tr×nh tù thùc hiÖn 

PhÇn nµy giíi thiÖu tæng quan vÒ c¸ch t¹o c¸c Sketch. Trong trî gióp trùc 

tuyÕn (onLine) Help vµ Tutorials sÏ cung cÊp  ®Çy ®ñ th«ng tin, thÝ dô tr×nh diÔn vµ 

c¸c b−íc cô thÓ. 

3.3.1. Ph¸c th¶o biªn d¹ng 

Mçi mét chi tiÕt ®Òu ®−îc khëi t¹o tõ mét Sketch. M«i tr−êng Sketch ®−îc 

thiÕt lËp ®Ó cã thÓ vÏ, chØnh söa vµ hoµn thiÖn c¸c Sketch mét c¸ch dÔ dµng. 



§Ó t¹o Sketch cho chi tiÕt míi  ta cÇn thùc hiÖn c¸c b−íc sau: 

1. Më file chi tiÕt míi (Part). 

2. Chän c«ng cô (lÖnh vÏ) trªn thanh c«ng cô Sketch. 

3. KÝch vµo cöa sæ ®å ho¹ ®Ó ph¸c th¶o biªn d¹ng. Chó ý r»ng c¸c biÓu t−îng  

(nh− c¨n vu«ng gãc hay c¨n th¼ng ®øng) sÏ xuÊt hiÖn ®Ó gîi ý c¸c rµng buéc cã thÓ 

®−îc g¸n.  

4. §ãng kÝn ®èi t−îng h×nh häc b»ng c¸ch chän ®iÓm ®Çu. Khi di chuyÓn chuét 

®Õn gÇn ®iÓm cã thÓ truy b¾t (Snap) th× con trá t−¬ng øng sÏ ®æi mµu. 

5. NhÊn phÝm ESC  hoÆc kÝch SELECT ®Ó kÕt thóc lÖnh. 

3.3.2. Thay ®æi kiÓu ®èi t−îng h×nh häc 

 Cã 3 kiÓu (Style) ®èi t−îng h×nh häc Sketch: Normal, Construction vµ 

CenterLine. Normal lµ kiÓu mÆc ®Þnh. Nã ®−îc dïng ®Ó t¹o c¸c Feature. KiÓu 

Construction ®−îc dïng ®Ó t¹o c¸c ®èi t−îng h×nh häc bæ trî cho ph¸c th¶o biªn 

d¹ng nh−ng kh«ng ®−îc dïng ®Ó t¹o Feature hoÆc ®−êng dÉn, Sweep  vµ Loft. KiÓu 

CenterLine chØ cã thÓ ¸p dông cho c¸c ®−êng (line). VÝ dô lÖnh Revolve nhËn ®−êng 

Centerline nh− mét trôc quay.  

§Ó thay ®æi kiÓu ®èi t−îng h×nh häc, ta kÝch chuét vµo mòi tªn bªn c¹nh hép 

danh s¸ch Style vµ chän Normal hoÆc Construction. §èi t−îng h×nh häc míi t¹o ra 

sÏ mang kiÓu nµy. §èi víi nh÷ng ®èi t−îng h×nh häc cã s½n tr−íc hÕt ph¶i chän ®èi 

t−îng, sau ®ã míi chän kiÓu. NÕu ta chän mét ®o¹n th¼ng th× kiÓu CenterLine sÏ 

hiÖn ra trong danh s¸ch Style. 

3.3.3. NhËp chÝnh x¸c c¸c gi¸ trÞ 

Ta cã thÓ nhËp gi¸ trÞ chÝnh x¸c (Precise Input) cho c¸c ®èi t−îng h×nh häc khi 

t¹o Sketch. §iÒu ®ã cã thÓ ®−îc thùc hiÖn víi c¸c c«ng cô Sketch cÇn nhËp täa ®é 

®iÓm. Cöa sæ nhËp täa ®é cã hai tr−êng X vµ Y. Ta cã thÓ nhËp c¶ hai gi¸ trÞ ®Ó ®Þnh 

nghÜa mét ®iÓm hoÆc chØ nhËp mét gi¸ trÞ X hoÆc Y ®Ó h¹n chÕ vÞ trÝ cña ®iÓm trªn 

®−êng th¼ng ®øng hoÆc n»m ngang. 

§Ó sö dông Precise Input, chän  VIEW ->Toolbar->Precise Input. 

3.3.4. ChØnh söa c¸c Sketch 

Khi mét Sketch ®· ®−îc t¹o ra, ta cã thÓ thùc hiÖn nhanh c¸c hiÖu chØnh ®Ó 

hoµn thiÖn nã tr−íc khi t¹o Feature. NÕu ®èi t−îng h×nh häc cña Sketch ch−a bÞ rµng 

buéc hoµn toµn, ta cã thÓ chØnh söa nã b»ng c¸ch kÐo rª. Ta cã thÓ ®Þnh d¹ng c¸c 

c¹nh cña m« h×nh còng nh− c¸c ®−êng cña Sketch. 



§Ó söa l¹i c¸c ®èi t−îng h×nh häc b»ng c¸ch kÐo, ta chän ®èi t−îng h×nh häc 

vµ kÐo sang vÞ trÝ míi. C¸c ®èi t−îng h×nh häc kh¸c cã liªn kÕt víi ®èi t−îng nµy sÏ 

tù ®éng di chuyÓn theo.  

§Ó söa nhiÒu ®èi t−îng b»ng c¸ch kÐo, gi÷ phÝm CTRL trong khi chän c¸c ®èi 

t−îng cÇn söa ®æi. KÐo ®èi t−îng ®−îc chän sau cïng th× c¸c ®èi t−îng kh¸c còng di 

chuyÓn cïng víi nã. 
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                   H×nh 3.2: ChØnh söa Sketch b»ng c¸ch kÐo 

3.3.5. Thªm bít c¸c rµng buéc 

Ta cã thÓ ®Þnh d¹ng  Sketch b»ng c¸ch thªm vµo ®ã nh÷ng rµng buéc h×nh häc. 

h÷ng rµng buéc sÏ h¹n chÕ kh¶ n¨ng biÕn ®æi cña ®èi t−îng vµ x¸c ®Þnh h×nh d¹ng 

ña Sketch. VÝ dô khi ®−êng th¼ng bÞ rµng buéc n»m ngang, khi ta kÐo ®iÓm cuèi 

ña nã th× hoÆc chiÒu dµi cña nã thay ®æi hoÆc nã sÏ dÞch chuyÓn th¼ng ®øng nh−ng 

ãc nghiªng cña nã sÏ kh«ng thay ®æi.  

MÆc dï ta cã thÓ sö dông nh÷ng Sketch kh«ng bÞ rµng buéc ®Çy ®ñ, nh−ng 

h÷ng Sketch ®−îc rµng buéc ®Çy ®ñ khi cËp nhËt sÏ cho h×nh d¹ng mong muèn. 

Æc dï c«ng cô tù ®éng ghi kÝch th−íc h¹n chÕ dïng cho Sketch nh−ng vÉn cã thÓ 

ö dông nã ®Ó g¸n rµng buéc. Nh−ng qu¸ tr×nh sÏ kÕt thóc khi Sketch bÞ rµng buéc 

oµn toµn. 



§Ó thªm mét rµng buéc, ta kÝch chuét vµo c«ng cô Constraint trªn thanh c«ng 

cô Sketch, sau ®ã chän ®èi t−îng h×nh häc cÇn thªm rµng buéc. Ta còng cã thÓ t¹o 

ra nh÷ng rµng buéc b»ng c¸ch kÐo ®èi t−îng h×nh häc cho ®Õn khi t¹i vÞ trÝ con trá 

xuÊt hiÖn ký hiÖu cña rµng buéc mong muèn. Autodesk Inventor sÏ tù ®éng nhËn 

biÕt rµng buéc ®ã lµ rµng buéc g× khi ta kÐo rª ®èi t−îng h×nh häc vµo vÞ trÝ t−¬ng 

øng (h×nh 3.3).  

 

 

 

 

 

 

 

 

 

 

H×nh 3.3. Tù nhËn biÕt rµng buéc 

§Ó xem hoÆc xo¸ bá rµng buéc, ta kÝch Show->Delete Constraints trªn thanh 

c«ng cô Sketch vµ di con trá lªn Sketch. C¸c rµng buéc sÏ hiÓn thÞ trong hép rµng 

buéc. Dõng con trá vµo mét ký hiÖu rµng buéc th× ®èi t−îng h×nh häc t−¬ng øng sÏ 

®æi mµu. Muèn xo¸ mét rµng buéc, kÝch ph¶i chuét vµo biÓu t−îng t−¬ng øng vµ 

chän Delete hoÆc di con trá vµo biÓu t−îng rµng buéc vµ Ên phÝm DELETE. 

§Ó di chuyÓn hép rµng buéc, ta kÝch vµo Grip vµ kÐo hép rµng buéc tíi vÞ trÝ 

mong muèn . 

 §Ó xem tÊt c¶ rµng buéc cïng mét lóc, ta kÝch chuét ph¶i vµ chän Show All 

Constraints trªn menu ng÷ c¶nh. Chän Hide All Constraints còng trªn menu nµy ®Ó 

®ãng toµn bé c¸c hép rµng buéc hoÆc chän nót Close trªn hép rµng buéc. 

3.3.6. G¸n kÝch th−íc 

KÝch th−íc x¸c ®Þnh ®é lín cña Sketch. Sau khi mét ®èi t−îng ®−îc g¸n kÝch 

th−íc, ta kh«ng thÓ thay ®æi ®é lín cña nã b»ng c«ng cô kÐo. Autodesk Inventor 

kh«ng cho phÐp g¸n trïng kÝch th−íc cho mét ®èi t−îng. 

Ta cã thÓ g¸n gi¸ trÞ sè cô thÓ cho mét kÝch th−íc. Nh÷ng kÝch th−íc nh− vËy 

®−îc gäi lµ kÝch th−íc tham sè. Khi söa ®æi kÝch th−íc tham sè, ta cã thÓ nhËp biÓu 

thøc gåm mét hoÆc nhiÒu tham sè. 



Ta cã thÓ g¸n kÝch th−íc suy diÔn (Driven Dimension). KÝch th−íc suy diÔn 

hiÓn thÞ ®é lín cña ®èi t−îng h×nh häc nh−ng ta kh«ng thÓ thay ®æi trùc tiÕp gi¸ trÞ 

cña nã. KÝch th−íc suy diÔn ®−îc sö dông ®Ó hiÓn thÞ c¸c kÝch th−íc dÉn ®Õn rµng 

buéc thõa vµ ®iÒu khiÓn tÝnh thÝch nghi cña Sketch. Xem thªm ch−¬ng 6 “L¾p r¸p” 

®Ó biÕt thªm chi tiÕt vÒ thÝch nghi. 

§Ó g¸n kÝch th−íc, ta kÝch vµo General Dimension trªn thanh c«ng cô Sketch. 

Chän ®èi t−îng cÇn ghi kÝch th−íc vµ di chuyÓn con trá tíi vÞ trÝ ®Æt kÝch th−íc. 

KÝch chuét lÇn n÷a ®Ó ®Æt vÞ trÝ ghi kÝch th−íc. Ta cã thÓ kÝch chän 2 ®iÓm vµ di 

chuyÓn con trá ®Ó t¹o kÝch th−íc ngang, ®øng hoÆc nghiªng. Chän 2 ®o¹n th¼ng ®Ó 

ghi kÝch th−íc gãc.  

§Ó chuyÓn mét kÝch th−íc thµnh kÝch th−íc suy diÓn, ta kÝch vµo c«ng cô 

General Dimension hoÆc chän kÝch th−íc cã s½n. Sau ®ã kÝch  vµo hép danh s¸ch 

Style vµ chän  Driven. Gi¸ trÞ cña kÝch th−íc nµy sÏ hiÓn thÞ trong ngoÆc ®¬n. 

§Ó tù ®éng g¸n kÝch th−íc rµng buéc thõa, ta chän Tool->Application Options. 

Sau ®ã chän thÎ Sketch, ®¸nh dÊu Apply Driven Dimension. NÕu ®¸nh dÊu vµo hép 

Warn of Overconstrained Condition th× mét hép tho¹i sÏ xuÊt hiÖn, hái cã muèn cËp 

nhËt c¸c kÝch th−íc thõa nh− lµ c¸c kÝch th−íc Driven hay kh«ng hoÆc huû bá lÖnh. 

§Ó cµi ®Æt chÕ ®é cho phÐp nhËp gi¸ trÞ khi ghi kÝch th−íc, kÝch Tools -> 

Application Options. TiÕp theo chän thÎ Sketch vµ ®¸nh dÊu vµo Edit Dimension 

When Created. Khi g¸n kÝch th−íc ta nhËp gi¸ trÞ cña nã vµo hép Edit Dimension. 

NhÊn phÝm CTRL trong khi g¸n kÝch th−íc sÏ bá qua cµi ®Æt nµy. 

 

     Tham sè kÝch th−íc 

 

 

 

    §¬n vÞ ®o kÝch th−íc 

    Gi¸ trÞ kÝch th−íc 

H×nh 3.4: Thay ®æi kÝch th−íc 

§Ó thay ®æi kÝch th−íc, kÝch vµo kÝch th−íc nÕu c«ng cô General Dimension 

®ang ho¹t ®éng hoÆc kÝch ®óp vµo kÝch th−íc cÇn thay ®æi trong chÕ ®é Select. Ta 

nhËp gi¸ trÞ míi hoÆc nhËp biÓu thøc to¸n häc trong hép tho¹i Edit Dimension. 

 

 

 



3.4. C¸c c«ng cô vµ biÓu t−îng cña SKETCH 

Bé c«ng cô Sketch bao gåm c¸c c«ng cô Sketch  vµ c¸c biÓu t−îng rµng buéc. 

3.4.1. C¸c c«ng cô Sketch 

 Mét sè c«ng cô Sketch  cã nhiÒu lùa chän. NÕu cã mòi tªn xuÊt hiÖn bªn c¹nh 

c«ng cô Sketch th× ta kÝch chuét vµo mòi tªn ®Ó më menu lùa chän. 

 

C«ng cô Sketch 

Nót LÖnh vÏ Cµi ®Æt/ Tuú chän ChØ dÉn ®Æc biÖt 

 
 

HiÖu chØnh c¸c to¹ ®é cña 

Sketch 

Quay l−íi (grid) 

 

Line 

 

VÏ ®o¹n th¼ng 

 

Chän Normal hoÆc 

Construction trong menu 

Style. 

 
Spline 

VÏ ®−êng Spline  

 

 

 

Circle 

VÏ ®−êng trßn biÕt t©m vµ b¸n 

kÝnh. 

VÏ ®−êng trßn tiÕp xóc víi 3 

®èi t−îng. 

VÏ Ellipse 

Chän Normal hoÆc 

Construction trong menu 

Style. 

 

 

 

Arc 

VÏ cung trßn: 

- §i qua 3 ®iÓm 

- BiÕt t©m vµ 2 ®iÓm cuèi 

- TiÕp xóc víi ®o¹n th¼ng 

hoÆc ®−êng cong t¹i ®iÓm 

cuèi cña ®o¹n th¼ng. 

Chän Normal hoÆc 

Construction trong menu 

Style. 

 

 

Rectangle 

VÏ h×nh ch÷ nhËt : 

- qua 2 gãc ®èi diÖn. 

- qua 3 ®Ønh 

 

 
Fillet 

Vª trßn gãc cña Sketch Hép tho¹i nh¾c nhËp b¸n 

kÝnh. 

 
Chamfer 

V¸t gãc cña Sketch §Þnh nghÜa kiÓu v¸t trong 

hép tho¹i. 



C«ng cô Sketch 

Nót LÖnh vÏ Cµi ®Æt/ Tuú chän ChØ dÉn ®Æc biÖt 

 

Point, Hole 

Center 

T¹o t©m lç hoÆc mét ®iÓm 

Sketch. 

Chän t©m lç  (mÆc ®Þnh) 

hoÆc ®iÓm Sketch tõ menu 

Style. 

 
Mirror 

§èi xøng ®èi t−îng vµ g¸n 

c¸c rµng buéc ®èi xøng. 

 

 
Offset 

T¹o ®−êng th¼ng hoÆc cong 

song song vµ c¸ch mét 

kho¶ng cho tr−íc.  

 

 

General 

Dimension 

G¸n kÝch th−íc cho Sketch  

 

Auto 

Dimension 

G¸n kÝch th−íc tù ®éng ®ång 

thêi rµng buéc hoµn toµn mét 

Sketch. 

Tr−íc hÕt ph¶i g¸n kÝch 

kh«ng muèn ghi tù ®éng.  

 
Extend 

KÐo dµi ®o¹n th¼ng hoÆc 

®−êng cong tíi giao víi ®o¹n 

th¼ng, cong hoÆc ®iÓm gÇn 

nhÊt. 

NhÊn phÝm SHIFT ®Ó t¹m 

thêi chuyÓn sang chÕ ®é 

TRIM (c¾t). KÝch ho¹t chÕ 

®é TRIM tõ menu ng÷ 

c¶nh. 

 
Trim 

C¾t bá mét phÇn ®èi t−îng. NhÊn phÝm SHIFT ®Ó t¹m 

thêi chuyÓn sang chÕ ®é 

EXTEND. KÝch ho¹t chÕ 

®é EXTEND tõ menu ng÷ 

c¶nh. 

 
Move 

Di chuyÓn hoÆc copy c¸c ®èi 

t−îng ®−îc nhËp tõ AutoCAD 

hoÆc c¸c ®èi t−îng Sketch. 

 

 
Rotate 

Quay hoÆc Copy c¸c ®èi 

t−îng ®−îc nhËp tõ AutoCAD 

hoÆc ®èi t−îng Sketch. 

 

 

Add 

Constraint 

T¹o rµng buéc vu«ng gãc  



C«ng cô Sketch 

Nót LÖnh vÏ Cµi ®Æt/ Tuú chän ChØ dÉn ®Æc biÖt 

 
 T¹o rµng buéc song song  

 
 

T¹o rµng buéc tiÕp xóc cña 

®o¹n th¼ng (cong) víi ®−êng 

cong. 

 

 
 

T¹o rµng buéc trïng khíp 

gi÷a c¸c ®o¹n th¼ng, cong 

hoÆc c¸c ®iÓm. 

 

 
 

T¹o rµng buéc ®ång t©m gi÷a 

2 ®−êng cong. 

 

 
 

T¹o rµng buéc th¼ng hµng 

gi÷a hai ®o¹n th¼ng hoÆc 2 

trôc. 

 

 
 

T¹o rµng buéc n»m ngang cña 

c¸c ®o¹n th¼ng, c¨n c¸c ®iÓm 

theo ph−¬ng ngang. 

 

 
 

T¹o rµng buéc th¼ng ®øng, 

c¨n c¸c ®iÓm theo ph−¬ng 

th¼ng ®øng 

 

 
 

T¹o rµng buéc chiÒu dµi b»ng 

nhau cña c¸c ®o¹n th¼ng hoÆc 

b¸n kÝnh.  

 

  

T¹o rµng buéc cè ®Þnh cho 

c¸c ®iÓm, ®o¹n th¼ng hoÆc 

®−êng cong trong hÖ to¹ ®é 

cña Sketch.  

 

 
Show 

Constraints 

HiÓn thÞ c¸c rµng buéc ®· 

g¸n. 

§−a con trá ®Õn rµng buéc, 

Ên phÝm DELETE ®Ó xo¸. 

 

Project 

Geometry 

ChiÕu ®èi t−îng h×nh häc lªn 

Sketch kh¸c. 

 

 

Project Cut 

Edges 

ChiÕu tÊt c¶ c¸c c¹nh cña chi 

tiÕt ®· chän lªn mÆt ph¼ng 

Sketch. C¸c c¹nh nµy ph¶i 

 



C«ng cô Sketch 

Nót LÖnh vÏ Cµi ®Æt/ Tuú chän ChØ dÉn ®Æc biÖt 

giao víi mÆt ph¼ng Sketch.  

 
Project Flat 

Pattern 

ChiÕu m¶ng ®èi t−îng ph¼ng 

lªn mÆt ph¼ng Sketch 

 

 

Insert 

AutoCAD 

file 

  

3.4.2. C¸c biÓu t−îng rµng buéc 

 

BiÓu 

t−îng 

Rµng buéc Nh÷ng chØ dÉn ®Æc biÖt 

 

Horizontal  

 

Vertical  

 

Parallel  

 

Perpendicular  

 

Coincident Con trá truy b¾t ®iÓm sÏ ®æi mµu khi 

rµng buéc nµy kÝch ho¹t 

 

Aligned §−êng nÐt ®øt hiÓn thÞ ®−êng n»m 

ngang hoÆc th¼ng ®øng. 

 

Tangent  

 

MÑo 

Ta cã thÓ thùc hiÖn nhanh c¸c lÖnh  cña Autodesk Inventor b»ng c¸c mÑo d−íi 

®©y: 

Ph¸c th¶o nhanh 

+ Cè g¾ng t¹o Sketch ®¬n gi¶n:  



VÝ dô ®Ó vª trßn c¹nh cña chi tiÕt, kh«ng nªn vª trßn gãc cña Sketch mµ thùc 

hiÖn ®iÒu ®ã sau khi chuyÓn Sketch sang m« h×nh 3D (tøc lµ ta kh«ng fillet sketch 

mµ ta fillet Feature). 

+ Cè g¾ng t¹o Sketch gÇn gièng víi biªn d¹ng mong muèn. 

Sö dông l−íi ®Ó vÏ. 

+  Hoµn thiÖn vÒ h×nh d¹ng tr−íc khi g¸n kÝch th−íc  

KÐo c¸c ®iÓm mót ®Ó ch¾c ch¾n c¸c rµng buéc cÇn thiÕt ®· ®−îc g¸n. ChØnh 

söa ®èi t−îng h×nh häc sao cho nã cã h×nh d¸ng vµ tû lÖ thÝch hîp. 

+ Sö dông c¸c Style 

Autodesk Inventor t×m c¸c ®èi t−îng h×nh häc cã kiÓu Normal khi nã nhËn  

mét biªn d¹ng hoÆc ®−êng dÉn ®Ó t¹o mét Feature. Trong c¸c Sketch phøc t¹p qu¸ 

tr×nh lùa chän biªn d¹ng sÏ nhanh h¬n vµ chÝnh x¸c h¬n nÕu ta chuyÓn toµn bé c¸c 

®èi t−îng tham chiÕu thµnh Construction. 

- C¸c phÝm t¾t khi t¹o Sketch: 

+ B¾t ®Çu ®o¹n th¼ng b»ng c¸ch kÐo mét cung trßn hoÆc mét ®−êng trßn.  

KÐo h−íng kÝnh ®Ó t¹o ®−êng vu«ng gãc, kÐo tiÕp tuyÕn ®Ó t¹o ®−êng tiÕp 

tuyÕn. 

 + B¾t ®Çu ®äan th¼ng b»ng c¸ch kÐo mét ®iÓm bªn trong ®−êng th¼ng kh¸c 

(kh«ng ph¶i lµ c¸c ®iÓm mót). §−êng th¼ng míi sÏ ®−îc rµng buéc vu«ng gãc víi 

®−êng th¼ng cã s½n. 

 + T¹o mét cung trßn b»ng c¸ch kÐo ®iÓm cuèi cña ®o¹n th¼ng.  

§−a con trá vÒ ®iÓm cuèi cña ®o¹n th¼ng ®Ó thay ®æi h−íng cña cung trßn. 

 + B¾t ®Çu mét ®−êng Spline tiÕp xóc víi mét ®o¹n th¼ng b»ng c¸ch kÐo ®o¹n  

th¼ng. Chän ®iÓm cuèi cña ®o¹n th¼ng, sau ®ã kÐo nã theo ph−¬ng tiÕp tuyÕn ®Ó kÕt 

thóc Spline tiÕp xóc víi ®o¹n th¼ng. 

 + T¹o c¸c rµng buéc trïng nhau. 

 Khi ta b¾t ®Çu mét ®−êng th¼ng, mét cung trßn hoÆc mét ®−êng trßn míi tõ 

mét ®−êng th¼ng cã s½n, Autodesk Inventor cã thÓ suy ra c¸c rµng buéc trïng khíp 

víi ®iÓm gi÷a, ®iÓm cuèi hoÆc ®iÓm bªn trong cña ®o¹n th¼ng. 

 + Bæ sung c¸c ®iÓm gi÷a (Midpoint) tíi ®o¹n th¼ng.  

KÝch vµo c«ng cô Point vµ chän kiÓu Sketch. ChØ thÞ b¾t dÝnh ®æi mµu khi ta 

kÝch vµo ®iÓm gi÷a cña ®o¹n th¼ng. Ta còng cã thÓ kÐo mét ®iÓm cã s½n tíi ®iÓm 

gi÷a cña ®o¹n th¼ng. 

 - C¸c phÝm t¾t ®Ó chØnh söa c¸c ®èi t−îng h×nh häc:   

 + Dïng phÝm SHIFT ®Ó kÐo.  



TÊt c¶ c¸c tiÖn Ých kÐo, trõ Spline tiÕp tuyÕn ®−îc kÝch ho¹t b»ng c¸ch nhÊn vµ 

gi÷ phÝm SHIFT trong khi di chuyÓn con trá. 

 + KÐo nhiÒu ®−êng th¼ng, cung trßn hoÆc c¸c ®iÓm cïng mét lóc.  

Chän c¸c ®èi t−îng h×nh häc trong khi gi÷ phÝm CTRL sau ®ã kÐo ®èi t−îng 

chän cuèi cïng. 

 + ChuyÓn ®æi gi÷a c«ng cô Trim vµ c«ng cô Extend:  

NhÊn phÝm SHIFT hoÆc chän c«ng cô kh¸c tõ menu ng÷ c¶nh ®Ó chuyÓn ®æi 

c«ng cô Trim vµ Extend. 

 - C¸c kü thuËt xö lý rµng buéc n©ng cao.    

  + T¾t c¸c rµng buéc tù ®éng.  

NhÊn vµ gi÷ phÝm CTRL trong khi ph¸c th¶o. 

 + Chän ®−êng cong cho rµng buéc. 

DÞch chuyÓn con trá trªn ®èi t−îng h×nh häc ta cÇn rµng buéc trong khi ph¸c 

th¶o.  

+ §Þnh nghÜa c¸c kÝch th−íc b»ng c¸c biÓu thøc:  

KÝch ®óp kÝch th−íc ®Ó më hép tho¹i Edit Dimension. KÝch vµo ®èi t−îng h×nh 

häc cÇn tham chiÕu vµ kÝch th−íc cña nã sÏ hiÖn trªn hép tho¹i. Ta cã thÓ ®Þnh nghÜa 

kÝch th−íc b»ng biÓu thøc to¸n häc ( vÝ dô D1*2). 

+ Ghi ®Ì ®¬n vÞ ®o cña mét kÝch th−íc ®¬n lÎ.  

 VÝ dô, trong file part ®· ®Æt kÝch th−íc theo hÖ mÐt, ta cã thÓ nhËp vµo 1 inch 
trong hép tho¹i Edit Dimension. 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Ch−¬ng 3    

3D Sketch 
 

Ch−¬ng nµy giíi thiÖu vÒ m«i tr−êng vÏ 3D Sketch, c¸c c«ng cô vµ thø tù thùc 

hiÖn khi vÏ Sketch 3D cho c¸c chi tiÕt d¹ng ®−êng dÉn. Xem nh÷ng th«ng tin tham 

kh¶o ®Çy ®ñ h¬n, c¸c vÝ dô tr×nh diÔn, c¸c chØ dÉn tõng b−íc trong trî gióp trùc 

tuyÕn (online Help) hoÆc Tutorial.    

3.1. Giíi thiÖu chung 

C¸c chi tiÕt d¹ng ®−êng dÉn ®−îc sö dông ®Ó t¹o c¸c ®−êng èng, c¸p, vµ c¸c 

lo¹i d©y ch¹y qua c¸c chi tiÕt trong côm l¾p r¸p. M«i tr−êng 3D Sketch trong 

Autodesk Inventor t¹o ra c¸c chi tiÕt d©y trong côm l¾p r¸p ®−îc thùc hiÖn ®¬n gi¶n 



vµ dÔ dµng. Ta cã thÓ lµm viÖc víi mét l¾p r¸p ®Ó t¹o ra ®−êng dÉn (path) cho c¸c 

Feature d¹ng 3D  Sweep hoÆc 3D Loft  vµ dÔ dµng tham chiÕu ®Õn  ®èi t−îng l¾p r¸p 

®· cã ®Ó ®Þnh vÞ cho nã. 

 
- T¹i sao l¹i sö dông m«i tr−êng Sketch 3D     

Ta cã thÓ tiÕt kiÖm thêi gian, t¨ng hiÖu qu¶ lµm viÖc khi ta lµm viÖc trong mét 

l¾p r¸p ®Ó t¹o c¸c ®−êng dÉn 3D m« t¶ c¸c chi tiÕt d¹ng khung d©y, c¸c ®−êng èng, 

c¸c ®−êng c¸p vµ ®Þnh vÞ chóng b»ng c¸ch sö dông c¸c ®iÓm lµm viÖc(Work Point) 

thÝch nghi tõ c¸c thµnh phÇn l¾p r¸p cã s½n. Ta còng cã thÓ ®Þnh nghÜa mét ®−êng 

dÉn 3D cho c¸c Feature d¹ng èng bªn trong mét chi tiÕt ®¬n lÎ.  

 
- Ta cã thÓ t×m c¸c c«ng cô t¹o 3D Sketch ë ®©u.  

Khi t¹o 3D Sketch mét biÓu t−îng Sketch sÏ ®−îc hiÓn thÞ trong cöa sæ duyÖt. 

Sau khi t¹o ®−îc chi tiÕt tõ 3D Sketch, mét biÓu t−îng chi tiÕt sÏ ®−îc xuÊt 

hiÖn vµ phÝa d−íi lµ biÓu t−îng cña 3D Sketch.   

3.2. C¸c tiÖn Ých 

D−íi ®©y lµ mét sè tiÖn Ých quan träng cã s½n trong m«i tr−êng 3D Sketch. 

3D Sketch:  

Cã thÓ ph¸c th¶o mét ®−êng 3D hoÆc c¸c ®o¹n 3D riªng biÖt theo bÊt kú tr×nh 

tù nµo sau ®ã hîp nhÊt chóng víi  ®èi t−îng h×nh häc 2D Sketch ®−îc chÌn. 

Include Geometry:  

Cã thÓ chiÕu mét ®èi t−îng h×nh häc 2D Sketch tõ mét m« h×nh ®−îc khëi t¹o 

tr−íc thµnh 3D Sketch. 

AutoBend:  

Cã thÓ t¹o uèn gi÷a c¸c ®o¹n kÒ nhau mét c¸ch tù ®éng khi t¹o Sketch. 

 

Adaptive work Feature:  

Cã thÓ tham kh¶o ®èi t−îng h×nh häc trªn c¸c chi tiÕt kh¸c khi ®Æt c¸c ®iÓm 

thÝch nghi cho c¸c ®−êng 3D  dïng trong c¸c ®−êng dÉn. 

 

3.3. Tr×nh tù lµm viÖc. 

D−íi ®©y lµ tæng quan vÒ c¸ch khëi t¹o vµ chØnh söa mét Feature d¹ng ®−êng 

èng 3D vµ c¸c b−íc thùc hiÖn. 



- LËp tr×nh tù thùc hiÖn. 

§Ó t¹o mét Sweep Feature, cÇn ®Þnh nghÜa 2D Sketch, ®Þnh nghÜa ®−êng dÉn 

3D (3D path), sau ®ã dïng lÖnh Sweep ®Ó Sweep biªn d¹ng 2D theo ®−êng dÉn 3D 

®ã. 

Ph−¬ng ph¸p t¹o ®−êng dÉn 3D  th−êng phô thuéc chñ yÕu vµo chi tiÕt cÇn t¹o 

ra. §èi víi d¹ng èng ta cã thÓ dïng c¸c ®o¹n th¼ng hoÆc c¸c cung trßn kÕt nèi víi 

nhau ®Ó t¹o ®−êng dÉn 3D, ®èi víi d¹ng chi tiÕt khung d©y th× sö dông c¸c ®−êng 

spline mµ th−êng ®−îc ®Þnh nghÜa bëi c¸c ®iÓm trªn mét sè mÆt ph¼ng lµm viÖc. Chi 

tiÕt d¹ng c¸p th× rÊt gièng d¹ng khung d©y vµ còng cã thÓ ®Þnh nghÜa  bëi mét ®−êng 

spline trõ tr−êng hîp nã ®· cã mét c¹nh spline. 

Sö dông  lÖnh 3D Line, cã thÓ t¹o sè l−îng bÊt kú c¸c ®o¹n th¼ng qua 2 ®iÓm 

hoÆc ®−êng dÉn 3D liªn tôc ®¬n kÕt nèi c¸c ®iÓm lµm viÖc ®Ó t¹o 3D Sketch. 

Cã thÓ gép c¸c ®èi t−îng h×nh häc cã s½n vµo 3D Sketch vµ cã thÓ tæ hîp mét 

®−êng dÉn 2D vµo ®−êng dÉn 3D vµ b»ng c¸ch chiÕu 2D Sketch lªn bÒ mÆt cña chi 

tiÕt 3D. C¸c ®o¹n uèn sÏ ®−îc thªm vµo ë c¸c gãc b»ng tay hoÆc tù ®éng. 

Cã thÓ sö dông c¸c ®iÓm lµm viÖc bï thÝch nghi ®· ®−îc khëi t¹o trªn c¸c chi 

tiÕt kh¸c ®Ó ®Þnh vÞ c¸c ®−êng dÉn 3D. 

§iÒu nµy cho thÊy r»ng cã thÓ t¹o c¸c Feature d¹ng 3D Sweep theo c¸c b−íc 

d−íi ®©y: 

1. T¹o bÊt kú c¸c bé phËn vµ c¸c ph¸c th¶o 2D  cÇn thiÕt mµ ta sÏ cÇn cã ®Ó 

chÌn vµo 3D Sketch, vÝ dô nh− biªn d¹ng 2D ®Ó Sweep biªn d¹ng 2D theo ®−êng dÉn 

3D. 

2. G¸n b¸n kÝnh uèn cña 3D Sketch vµ c¸c gi¸ trÞ b¾t dÝnh 3D trong Tools-

>Document Settings. 

3. T¹o c¸c ®iÓm lµm viÖc thÝch nghi trªn c¸c chi tiÕt kh¸c ®Ó ®Þnh vÞ  ®−êng 

3D. 

4. NÕu cÇn bao gåm  ®èi t−îng h×nh häc tõ c¸c thµnh phÇn l¾p r¸p cã s½n kh¸c 

cho c¸c bé phËn cña h×nh d¸ng ®−êng dÉn th× chiÕu nã lªn 3D Sketch. 

5. Ph¸c th¶o h×nh d¹ng ®−êng dÉn, b¾t dÝnh tíi c¸c ®iÓm lµm viÖc, c¸c ®iÓm 

th¼ng ®øng vµ c¸c ®iÓm nót cña c¸c ®o¹n ®èi t−îng h×nh häc ®−îc bao gåm.  

6. G¸n c¸c ®o¹n uèn ë gãc tiÕp tuyÕn b»ng c¸ch sö dông c«ng cô Bend ë chÕ 
®é 3D Sketch. 

7. KÝch chuét ph¶i chän Finish 3D Sketch. 

8. T¹o biªn d¹ng 2D  trªn mÆt ph¼ng vu«ng gãc víi ph¸c th¶o ®−êng dÉn. 

9. Sö dông c«ng cô Sweep ®Ó chän biªn d¹ng 2D  vµ 3D Sketch. 

10. §Þnh nghÜa c¸c tham sè Sweep cßn l¹i vµ kÝch OK ®Ó t¹o Sweep Feature.     



 

3.4. Ph¸c th¶o c¸c ®−êng dÉn 3D 

B»ng c¸c c«ng cô trong thanh c«ng cô 3D Sketch ta cã thÓ ph¸c th¶o ®−êng 

dÉn 3D vµ ®Þnh vÞ chóng trong l¾p r¸p. NÕu ta cã ý ®Þnh gép ®èi t−îng 2D vµo 3D 

Sketch ta cã thÓ t¹o ®èi t−îng 2D tr−íc khi t¹o 3D Sketch. 

§Ó t¹o ®−êng dÉn 3D:  

B¾t ®Çu trong file l¾p r¸p. KÝch vµo menu Insert->New Component. Trong file 

chi tiÕt míi, ph¸c th¶o vµ ®ïn mét biªn d¹ng. Trªn thanh Command më réng nót 

Sketch vµ chän 3D Sketch. T¹o c¸c Work Feature vµ ®èi t−îng 3D Sketch cho ®−êng 

dÉn , gép c¸c ®èi t−îng 2D cÇn thiÕt. 

T¹o ®−êng 3D:  

KÝch 3D Sketch trªn thanh Command. KÝch chän c«ng cô 3D Line trªn thanh 

c«ng cô 3D Sketch. KÝch ph¶i chuét vµ g¸n tuú chän Auto-Bend ®Ó tù ®éng t¹o uèn 

cong t¹i c¸c gãc. Ph¸c th¶o ®−êng dÉn vµ chän c¸c ®iÓm lµm viÖc, c¸c ®iÓm th¼ng 

®øng vµ c¸c ®iÓm 3D Sketch trong 3D Sketch hiÖn hµnh. NÕu ta cÇn ®Ëp g·y mét 

®−êng  kÝch chuét vµo ®iÓm cuèi cña nã. KÝch chuét ph¶i vµ chän Restart sau ®ã 

kÝch chän ®iÓm phï hîp ®Ó b¾t ®Çu mét ®−êng kh¸c. 

Gép ®èi t−îng h×nh häc vµo 3D Sketch:  

KÝch chuét vµo c«ng cô Include Geometry, tiÕp theo kÝch vµo c¸c c¹nh cña m« 

h×nh vµ ®èi t−îng h×nh häc cña 2D Sketch ®Ó chÌn. §Ó kÕt thóc kÝch chuét ph¶i chän 

Done. 

ChØnh söa 3D Sketch:  

KÝch chuét ph¶i vµo Sketch trong cöa sæ duyÖt vµ chØnh söa c¸c ®−êng vµ  

®o¹n uèn cong nÕu cÇn.  NÕu chØnh söa c¸c chi tiÕt cã s½n vµ lo¹i bá ®èi t−îng h×nh 

häc hoÆc chi tiÕt mµ cã rµng buéc víi ®−êng dÉn, ta sö dông Redefine Point  ®Ó rµng 

buéc l¹i c¸c ®−êng th¼ng 3D Sketch  tíi c¸c ®iÓm phï hîp (valid) hoÆc c¸c ®iÓm 

th¼ng ®øng. 

 

3.5. T¹o uèn cong trong c¸c ®−êng dÉn 3D 

Ta cã thÓ t¹o uèn cong trong c¸c ®−êng 3D b»ng tay hoÆc tù ®éng b»ng ®Æc 

tÝnh Auto-Bend. §Ó g¸n uèn cong b»ng tay, ta b¾t ®Çu tõ ®èi t−îng 3D Sketch cã 

s½n. Khi ta sö dông Auto-Bend, c¸c ®o¹n uèn  ®−îc t¹o ra tù ®éng trong khi ph¸c 

th¶o ®èi t−îng h×nh häc 3D. 

§Ó  g¸n ®o¹n uèn cong trªn ®−êng 3D b»ng tay:  



§Ó  g¸n ®o¹n uèn cong trªn ®−êng 3D b»ng tay th× hoÆc lµ t¹o c¸c  ®èi t−îng 

3D Sketch  hoÆc lµ kÝch chän  biÓu t−îng 3D Sketch trong cöa sæ duyÖt vµ chän 

Edit. Sö dông c«ng cô Bend ®Ó g¸n b¸n kÝnh cong vµ ®Þnh nghÜa c¸c ®o¹n uèn cong. 

Chän c¸c ®−êng 3D, c¸c ®iÓm ph¸c th¶o hoÆc gép ®èi t−îng 2D mµ xuÊt hiÖn t¹i 

gãc. 

§Ó tù ®éng t¹o c¸c ®o¹n uèn cong trªn ®−êng th¼ng 3D:  

Tr−íc hÕt ta ®Æt 2 tham sè Auto-Bend. §èi víi c¸c tham sè hÖ thèng, kÝch 

chän Tools->Document Settings->Sketch Tab, ®¸nh dÊu vµo hép kiÓm Auto-Bend 

with 3D Line Creation. §Ó ®Æt tham sè cho file hiÖn hµnh kÝch chuét vµo Tools-

>Document Settings->Sketch tab. Trong hép 3D Sketch, nhËp b¸n kÝnh Auto-Bend  

vµ chän OK. Khi ta dïng c«ng cô 3D Line ®Ó t¹o ®−êng th¼ng 3D, c¸c ®o¹n uèn 

cong sÏ tù ®éng t¹o ra bæ sung vµo c¸c gãc. 

 

Chó ý: NÕu ta xo¸ mét ®o¹n uèn  cong hoÆc b¸n kÝnh cña ®o¹n uèn cong qu¸ 

lín ®Ó ®iÒu chØnh c¸c ®o¹n cho võa th× gãc trong ®−êng 3D  bÞ trë l¹i. 

 

3.6. §Þnh vÞ trÝ cho c¸c ®−êng dÉn 3D  

Ta t¹o Sketch 3D b»ng c¸ch liªn kÕt c¸c ®iÓm lµm viÖc víi nhau. C¸c ®iÓm lµm 

viÖc nµy cã thÓ ®−îc offset tõ c¸c thµnh phÇn cã s½n cña l¾p r¸p sö dông  c¸c ®iÓm 

offset gãc mµ ®· ®−îc thÝch nghi. Sau khi c¸c ®iÓm ®· ®−îc t¹o ra, ta cã thÓ sö dông 

c«ng cô AutoHide ®Ó che khuÊt tÊt c¶ trõ Work Feature hiÖn hµnh. 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

3.7. C¸c c«ng cô 3D  Sketch 

C¸c c«ng cô 3D Sketch th× t−¬ng tù víi mét vµi c«ng cô cã s½n trong 2D 

Sketch vµ trong m« h×nh chi tiÕt. 

 

3D Sketch Tools 

N

ót 

C«ng cô Cµi ®Æt/ Tuú chän ChØ dÉn ®Æc 

biÖt 

§−êng th¼ng 

3D  

T¹o c¸c ®o¹n th¼ng 3D 

®i qua c¸c ®iÓm lµm viÖc 

®−îc lùa chän s½n, c¸c ®iÓm 

th¼ng ®øng vµ ®èi t−îng 

h×nh häc  

KÝch chän ®Ó 

bÎ g·y ®−êng th¼ng, 

kÝch ph¶i chuét vµ 

chän Restart ®Ó b¾t 

®Çu ®−êng th¼ng 

míi. 

MÆt cong( 

Bend)  

G¸n b¸n kÝnh vµ kÝch 

th−íc mÆc ®Þnh cña mÆt 

cong cho c¸c gãc ®· chän.  

 

bæ sung ®èi 

t−îng h×nh häc 

ChÌn 2D Sketch vµo 

3D Sketch 

 

MÆt ph¼ng lµm 

viÖc 

T¹o mÆt ph¼ng lµm 

viÖc 

 

§−êng trôc lµm 

viÖc 

T¹o ®−êng trôc lµm 

viÖc 

 

§iÓm lµm viÖc C¸c ®iÓm ®Þnh vÞ cã 

liªn hÖ víi ®èi t−îng h×nh 

häc trªn c¸c Feature kh¸c.  

 

 

MÑo: 

Ta cã thÓ n©ng cao hiÖu qu¶ vµ tèi −u viÖc thùc hiÖn cña Autodesk Inventor 

b»ng c¸c kü n¨ng sau ®©y: 

- Khi ta cã ý ®Þnh gép ®èi t−îng h×nh häc 2D vµo 3D Sketch, ta t¹o ®èi t−îng 

h×nh häc 2D  tr−íc khi t¹o 3D Sketch. 

- T¹o biªn d¹ng 2D sau khi t¹o 3D Sketch. 



- Khi lµm viÖc trong m«i tr−êng l¾p r¸p, ta t¹o file chi tiÕt riªng cho Feature 

3D Sweep. 

- Sö dông c¸c Work Feature  thÝch nghi tham chiÕu  tõ c¸c chi tiÕt kh¸c ®Ó dÞnh 

vÞ c¸c ®iÓm cho c¸c ®−êng 3D. 

- §Ó ®¬n gi¶n khi hiÓn thÞ 3D Sketch, dïng tuú chän Auto-Hide  trªn 

Application Tools->Part tab. 

 


	3.1. Giíi thiÖu chung
	3.1.1. C«ng dông cña Sketch
	3.1.2. Khëi ®éng m«i tr­êng Sketch

	3.2. C¸c tiÖn Ých t¹o Sketch
	3.3. Tr×nh tù thùc hiÖn
	3.3.1. Ph¸c th¶o biªn d¹ng
	3.3.2. Thay ®æi kiÓu ®èi t­îng h×nh häc
	3.3.3. NhËp chÝnh x¸c c¸c gi¸ trÞ
	3.3.4. ChØnh söa c¸c Sketch
	3.3.5. Thªm bít c¸c rµng buéc
	3.3.6. G¸n kÝch th­íc

	3.4. C¸c c«ng cô vµ biÓu t­îng cña SKETCH
	3.4.1. C¸c c«ng cô Sketch
	3.4.2. C¸c biÓu t­îng rµng buéc

	MÑo
	Ph¸c th¶o nhanh

	3.1. Giíi thiÖu chung
	- T¹i sao l¹i sö dông m«i tr­êng Sketch 3D
	- Ta cã thÓ t×m c¸c c«ng cô t¹o 3D Sketch ë ®©u.


	3.2. C¸c tiÖn Ých
	3.3. Tr×nh tù lµm viÖc.
	3.4. Ph¸c th¶o c¸c ®­êng dÉn 3D
	3.5. T¹o uèn cong trong c¸c ®­êng dÉn 3D
	3.6. §Þnh vÞ trÝ cho c¸c ®­êng dÉn 3D
	3.7. C¸c c«ng cô 3D  Sketch
	MÑo:

